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From the
Presidentby Dave Rensink

Ihad hoped to debunk a few myths about the oil industry this

month. Unfortunately, there are so many myths at both ends of

the spectrum that it is difficult to know where to start. There

seems to be an element of truth in most of them regardless of their

orientation. In some cases, the element of truth may be very small.

In other cases, it is a matter of semantics. Such as the “myth” that

contends that production from the Arctic National Wildlife Refuge

will do little to reduce our dependence on oil imports from Saudi

Arabia; therefore, it does not justify exploiting a pristine wilder-

ness. The first part of that statement is probably true on two levels.

The United States imports more oil from

Canada, Mexico and Venezuela than it does from

Saudi Arabia, thus any imports that may be offset

could be allocated across the board and the 

specific reduction on Saudi oil would be limited.

In addition, any production that may ultimately

come from the Arctic National Wildlife Refuge is

several years in the future, if it ever comes, and

would likely do more to offset the declining 

production of the lower 48 states and the North

Slope than reduce imports. Hence, the myth is

partly correct. It just depends on how you look at it. The probability

that any myth could be convincingly debunked is probably low. Of

course, long odds do not keep us from drilling wells, and they do

not keep me from tilting windmills.

There are a couple of myths that can be addressed and at least

partially debunked. The first is that the oil industry owns

Washington, DC. Since money and influence are virtually 

synonymous in DC, this contention is probably based on the

amount of political contributions that come from oil and gas

sources. However, the $26 million the oil and gas industry con-

tributed during the 2004 elections ranked 16th among the various

industries tracked by The Center for Responsive Politics — far

behind such notables as lawyers and law firms ($182 million), real

estate ($96 million), securities and investments ($91 million), and

health professionals ($74 million). If money talks, it is no surprise

that lawyers have such a large influence inside the DC beltway.

Much has been made in the media of the oil industry’s (especially

Enron’s) input into oil-related legislation, but most of the legisla-

tion beneficial to the oil industry has gained little support in

Congress. Either the oil industry’s influence far exceeds the level

of its contributions or its influence has been greatly exaggerated

by virtue of the prior association President Bush and Vice

President Cheney had with the oil industry. The overriding fact is

that, at present, high oil and natural gas prices are providing the

industry with record or near-record profits; therefore, the oil

industry does not need much assistance from Washington, DC.

Interestingly, the largest political contributions in

2004 came from the “retired” in the amount of

$184 million. This figure obviously includes 

contributions from AARP’s war chest. With that

type of access and presumed influence, it is a 

little short of amazing that the problems of the

Social Security system have not been solved.

The other windmill worth tilting is the perception

that the oil industry controls the price of crude

oil. This assertion has the same relevance as saying

the farmers control the price of corn. I will acknowledge that the

industry may have controlled the price prior to 1973.That period

was characterized by price stability in the extreme, it should be

noted. The only price increase of note between 1920 and 1973

was during the economic expansion immediately following the

Second World War. If you are making decisions on large, long-

term capital investments, price stability at economic levels is a

good thing, not a bad thing. OPEC did as good a job as they could

between 1973 and 2000 to regulate prices in a range that was high

enough to provide them with good returns, but low enough to

preserve their market share. As efficient as OPEC tried to be, the

price fluctuations under their watch were orders of magnitude

greater than before 1973. Even those fluctuations seem minor

when compared with the period since 2000. If the nabobs of the

oil industry are now regulating the price of oil, they have certainly

become sloppy and inefficient since 1973. They are also acting

counter to their own best interests. Oil executives have stated that

price stability, even at a lower price, is more conducive to 

The probability that

any myth could be

convincingly

debunked is 

probably low.

From the President continued on page 7

Myths, Half-Truths and Other Bits of Trivia
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long-term planning than extreme price fluctuations. A 

predictable market takes some of the risk out of large investment

decisions.

I need to credit the Wilderness Society for pointing out how

effective fuel efficiency can be in reducing oil consumption,

although I think it may have misquoted the EPA. The original

quote is “According to the Environmental Protection Agency,

increasing fuel efficiency standards for new vehicles by just 

3 miles per gallon would save more than 1 million barrels of oil

per day.” My initial thought was that this was an exaggeration of

some magnitude. However, that is a true statement if it is applied

to the average fuel efficiency of the entire fleet of automobiles

and light trucks on the road today and not merely to the new

vehicles. The 240 million automobiles and light trucks in the

United States consume approximately 380 million gallons of

gasoline per day with an average fuel efficiency of approximately

20 mpg. That means Americans drive about 7.6 billion miles or

32 miles per vehicle every day. The fuel efficiency numbers work

when applied to the total automotive fleet; increasing the average

fuel efficiency to 23 mpg will indeed save 1 million barrels of oil

per day. It is not a myth; a 15% increase in average fuel efficiency

on all automobiles and light trucks will ultimately result in a 5%

reduction in US oil consumption.

Help Wanted
The HGS Academic Liaison Committee needs a few more geolo-

gists who are willing to speak to Houston’s students. They have

been unable to fulfill requests from area teachers for guest speakers

recently because of scheduling conflicts among the pool of

volunteers. We need to expand the size of the pool. If you have

the desire and the time for a little outreach to area students,

contact Alison Henning. Her contact information is found at the

front of the Bulletin. She would be happy to help you craft a 

presentation, if you do not already have one. The HGS also has

resource materials available for your use. Facing a room full of

students can be intimidating, but someone needs to bring them

word of the real world of science. Why not you? n
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New Orleans HGS member MICHAEL MACKENZIE reports that

since mid-October, he has been back in his office in New

Orleans. All office and home data currently listed in the latest

HGS Membership Directory are current and correct.

500 judges Needed for AAPG Meeting
The 2006 AAPG Meeting in Houston from April 9 – 12, needs

500 JUDGES for Oral (Matson Award), Poster (Braunstein

Award) and SEPM presentations. Please participate as a Judge

by contacting: shensley@aapg.org 

Academic Liaison Committee seeks Volunteers
Interested in visiting local schools to discuss geology? Join the

Academic Liaison Committee. Contact Alison Henning at

Alison@henning.com or 832-203-5016 for more information.

Science & Engineering Fair Internship 
In honor of RICHARD HOWE’S extensive service to the Science

and Engineering Fair of Houston (SEFH), one of the two 

HGS-sponsored student internships at the Houston Museum

of Natural Science has been designated the Richard Howe

Internship. This internship will be awarded for the first time at

the 2006 SEFH to be held March 23 – 25.

SEVERE STORMS 
Impact & Disaster Response in Gulf Coast
Communities
Rice University presents a two-day conference open to the 

public, organized by Dr. Philip Bedient:

March 15-16-17, 2006

Rice University - Duncan Hall - McMurtry Auditorium

Conference fee: $200.00.

REGISTER AT:

https://cohesion.rice.edu/services/eventreg/?event=SSID

With experts from the private, public and academic sectors, the

conference will focus on the technical, social and economic

issues associated with tropical storms and hurricanes in Gulf

Coast communities. Hurricanes Katrina and Rita — what we

expected and what we experienced — will, of course, feature

prominently in the conference's coverage.

For agenda and full conference information, go to:

http://hydrology.rice.edu/

Please register soon since seating is limited!

Sponsored by:

Environmental & Energy Systems Institute

Department of Civil & Environmental Engineering

Member News and Announcements
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Mt. Augustine Volcano
Before getting into the main topic for the month, a review of last

month’s article on Mt. Augustine is in order. At

press time last month, the volcano had erupted

twice. Since then, it has erupted numerous

more times. Nine explosive eruptions of

Augustine Volcano occurred between January

11 and 17, each sending volcanic ash to more

than 30,000 ft above sea level, and associated

pyroclastic flows and rockslides were reported.

On January 28, five more explosive eruptions

occurred, the last destroying two seismic sta-

tions and one continuous GPS station, leaving four seismometers

and three GPS stations operational on the island. Following the

last eruption, the volcano remained in a state of continuous erup-

tion and accompanying ash emission, and continued erupting as

of February 2.

Elevated seismic activity and the observance of thermal anomalies

throughout the island area associated with the volcanic activity

continue to be observed. The Alaska Volcano Observatory (AVO)

is continuously monitoring the activity with seismic stations, aer-

ial over-flights and a live webcam. The webcam allows the public

to view the volcanic activity at www.avo.alaska.edu.

The observations being made on this volcano

will greatly aid in the study and possibly the

predictability of volcanic eruptions worldwide,

leading to further protection of health and

public safety from such hazards.

The Long Point Fault
The Long Point Fault is an active surface fault

that spans much of the northwest and west

part of the Houston metropolitan area. It is

over 10 miles in length, and is second only to the Hockley Fault in

vertical displacement. It has damaged 204 structures, according to

Dr. Carl Norman, as well as roadways and parking lots in its path.

The Sam Houston Tollway overpass structures near I-10 have

been built to accommodate its

by Paul Britt
editor@hgs.org

From the
Editor

TOP TEN REASONS YOU MIGHT BE A GEOLOGIST: *

4. Your photos include people only for scale and you have more

pictures of your rock hammer and lens cap than of your family

next month, reason no. 3…

Mt. Augustine Volcano — Erupting
The Long Point Fault — Exposed

The west side of the detention pit showing the discoloration defining the fault blocks.

The Long Point Fault …

is over 10 miles in

length, and is second

only to the Hockley Fault

in vertical displacement.

From the Editor continued on page 11
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movement. Its destruc-

tive power has been

fairly well documented.

But while it can be seen

in map view by its dam-

age, it has rarely been

observed in an inclined

or cross-sectional view

— until now.

Recently, the Igloo

Plant (of Igloo cooler

fame), at the northwest

corner of the I-10 and

the West Sam Houston

Tollway intersection,

was demolished, and a

storm-water detention

pond was excavated as a

part of the I-10 expan-

sion project, exposing a

view of the Long Point

Fault where it intersects

the pond wall at a scale never previously seen.

Photos of this feature were provided to the Bulletin by Richard

Howe and Bruce Woodhouse. Accompanied by Carl Norman and

Gary Kowalczyk, this intrepid group of explorers braved the wilds

and weather of west Houston on a Saturday in January to bring

these observations to the HGS membership.

The west wall of the pond can be clearly seen from the comfort of

your own car while driving southbound on the West Sam

Houston Tollway, and is a recommended trip for all interested

Houston geologists before the exposure is covered up.

While Richard and Carl were annotating the photo for publica-

tion, Carl noticed that the structural problem of two intersecting

planes (the Long Point Fault and the detention pond wall) would

show a misleading angle of the fault plane, if drawn properly.

At my request, he provided the following structural geology

problem. The answer will appear in next month’s Bulletin.

Given:
• Orientation (strike) of the pond wall is north-south and the

wall face is dipping east 23 degrees.

• Strike of the fault is N68E dipping southeast 74 degrees.

Problem:
• What is the plunge and bearing of the line of intersection

between the wall and the fault plane?

• What is the pitch (rake) in the exposure plane (wall surface)?

• While facing the wall (due west), which direction would you

expect to see the fault plane dipping if it were visually more dis-

cernable?

• What illusion could you expect the fault’s intersection with the

wall to produce?

Use of a stereo net is recommended, however a descriptive geom-

etry solution can also be used. I bet you thought you were done

with this type of problem when you graduated college. For those

inclined to do so, send your answers to editor@hgs.org. n
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rFrom the Editor continued from page 9 ___________________________________________________________________________________________________________________

A closer view of the fault zone. Gary and Bruce shown for scale (see reason no. 4 above). The fence-line break is offset
due to the strike of the fault.

Richard Howe, Gary Kowalczyk and Carl Norman.
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Operators still encounter structural surprises while drilling

for remaining reserves in well-established, mature fields,

even with 3D seismic coverage, on the Gulf of Mexico shelf.

These surprises are associated with the nature

of the remaining development opportunities

along major fault systems. Fields that 

have attic reserves in stacked pay horizons 

are being targeted via increasingly complex

well paths.

Wells designed to target both shallow and

deep reservoirs and develop remaining

reserves often find that the shallow structures

are penetrated as mapped. Deeper horizons, below major faults

and being within seismic “fault shadows,” have inherently less

well control and are more problematic to predict. New well paths

must be carefully designed using all available subsurface data

when developing remain-

ing stacked target horizons.

O n e  p r o b l e m  i s  t h a t  

seismic structure maps

may show conforming

structural positions in both

shallow and deep target

horizons, but subsurface

well control has a poorer

quality match of structural

conformance betweeen

individual horizons.

The data presented here

strongly suggest that, with-

in an area with 3D seismic

coverage, subsurface well

control is needed in devel-

opment mapping, especially

when targeting multiple fault-sealed reservoirs. This is specifically

true when the target reservoirs are located in areas of limited or

masked seismic resolution owing to proximity to the sealing fault

systems. Slight variations in seismic depth

conversion of mere fractions of a percent,

at depths of about 10,000 feet or more, can

be decisive for a development prospect if

structural gains are merely in the tens of feet

to offsetting well control. The case discussed

here is an example of known structural vari-

ations of chronologically and generically

linked stratigraphic units. Variations in 

reservoir quality were also found within a

few hundred feet, apparently governed by local facies changes.

Understanding both factors significantly mitigates drilling risk

and helps operators devise appropriate development strategies.

The Value of an Integrated Subsurface Model: 3D
Seismic Limitations in Prediction of Reservoir in the

Grand Isle Production Area, Offshore Louisiana

HGS General 
Dinner Meeting 

Monday, March 13, 2006
Westchase Hilton  •  9999 Westheimer
Social 5:30 p.m., Dinner 6:30 p.m.

Cost: $25 Preregistered members; $30 non-members & walk-ups

The HGS prefers that you make your reservations on-line through
the HGS website at www.hgs.org. If you have no Internet access, you
can e-mail reservations@hgs.org, or call the office at 713-463-9476
(include your name, e-mail address, meeting you are attending, phone
number and membership ID#).

by Ingo Steinhoff
and William A. Hill
BP America, Inc
Houston, Texas 

Subsurface well control is

needed in development

mapping, especially 

when targeting multiple

fault-sealed reservoirs.
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Figure 1: Location map of study area in Grand Isle on the Louisiana shelf of the Gulf of Mexico.

HGS General Dinner Meeting continued on page 15
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Seismic Must Be Integrated with Subsurface Well
Control to be Effective
To demonstrate the challenge of using and relying on 3D seismic

data, this talk will describe an example of a development well

drilled in early 2004 in the Grand Isle area designed to develop

remaining attic reserves (Figure 1). The new well targeted both

Pliocene (between –12,500 and –12,700 feet TVDSS) and Upper

Miocene (between –13,350 and –13,800 feet TVDSS) reservoirs

on a typical three-way, upthrown closure along a major down-to-

the-south growth fault (Figure 2). The development targets are

not supported by 3D seismic amplitude anomalies on the data.

Hydrocarbon prospectivity was identified using offset penetra-

tions and production in the area.

Three proposed deep target horizons were identified by four

observations: 1) pay in offsetting wells, 2) the structure in the

deep section as rendered in the seismic volume, 3) same structure

in the shallow section as verified by both seismic and well control

and 4) structural conformance of shallow and deep horizons.

More well control existed for defining the structure of the shal-

low targets in the prospect three-way closure than for the deep

targets. The 3D seismic data and well control from six wells con-

firmed the overall structural picture and narrowed the target area

for the planned well close to the apex of the shallow structure

area. Seismic data initially indicated that the deep target was con-

formable with the shallower target horizons. Deep penetrations

were sparse, but some offset wells had logged pay to the west and

northwest of the crest of the closure. The closest well to the pro-

posed new well, in the same fault block, was the 1955

straight-hole discovery well for this part of the field, originally

drilled on 2D seismic. This 1955-era well was located about 900

feet to the west of the new development well location and had

about 20 feet of pay in each of the deep horizons (Figure 3).

Because the risk of correctly imaging the crest of the structure in

the deep horizons was deemed to be high, a contingency plan was

devised to sidetrack the well and to twin the deep section of the

discovery well.

The main risk in drilling this development well was our team’s

ability to predict and achieve a structural gain of 20 to 30 feet

above the old discovery well. Post-drill results showed that the

structure was correctly predicted in the shallower part of the new

well and multiple pay zones were encountered. However, all three

deeper horizons were encountered about 20 to 25 feet structural-

ly deeper than in the old discovery well, and 20 to 45 feet deeper

than predicted from the 3D seismic data. All were wet.

HGS General Dinner Meeting continued from page 13 ____________________________________________________________________________________________
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Figure 2: Overview of targeted structure and original well path; ST = shallow target, DT = deep target, Sh. Offset = shallow offset well. A) 
north-south section; B) east-west section, where solid lines indicate the mapped seismic reflectors and dashed lines mark tops of deep targets as
encountered by wells. DTTS = down-to-the-south

HGS General Dinner Meeting continued on page 17
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Figure 3: Geologic interpretation based on well data reveals actual structural and lithostratigraphic setting. Approximate position of seismic 
reflectors is also shown. Structure predictions of top of reservoir decrease from bottom to top sand unit due to internal facies variations.
DT = deep target.
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Another attempt to side-track to these missed targets revealed a

more complete picture of the actual structure and stratigraphy of

the deep target section. The deepest target, encountered at a 

distance of only about 100 feet from the old discovery well and

about 5 feet higher, logged about 5 vertical feet more pay. The

side-track successfully tested the actual crest of the structure on

the deepest target 100 feet from the old discovery well. The 

variability of the stratigraphic thickness of sands and shales

posed an additional component of risk to the prediction of struc-

ture of actual reservoir-quality rock in the deeper section of

interest. The seismic was only about 20 to 45 feet off, which

accounts for an error of only ~0.3% at this depth. Apparent oil/

gas seismic-based structural conformance over 1000 feet of

section may be misleading when the amount of structural gain is

comparatively small (in this case ~3.5% over the interval studied).

Conclusions
Exclusively relying on 3D seismic data to predict structure along

major faults is very risky when development teams attempt to

develop remaining reserves on the Gulf of Mexico shelf. In the case

described, only the seismic structure of shallow targets could be

confirmed by a new development well, while structures of deeper

targets were predicted incorrectly. Due to limited deep well control

penetrations, little was known about reservoir variations in the

deeper section across the prospective fault block, but drilling

results show the importance of having well data to reduce risk

around both reservoir and structure. Well control should be com-

bined with seismic data as much as possible when planning more

complex wells to stack remaining reserves in old fields. Subsurface

maps and models should be updated as the field life is extended by

drilling and completion activities. An inherent risk when prospect-

ing for remaining reserves, especially on broad shallow structures,

is subseismic faulting. Small faults can remain undetected by both

seismic and well control, causing unexpected structural results for

predicted stratigraphic markers and so should be included in the

risk profile of any given development project, especially when

throws on these faults exceed reservoir thickness.n
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Forming a subsurface image from recorded seismic data 

has truly become a mathematical physicist’s delight. Today,

virtually every seismic imaging module is based on someone’s

favorite very complex coupled first-order or second-order 

partial-differential equation or equations. To the not-so-mathe-

matically inclined, the algorithmic hierarchy is a bewildering dia-

gram of confusing labels, terminology and, worse, complicated

underlying explanations.

Therefore, it might be surprising to current practitioners of the art

to learn that this was not always the case. Seismic imaging has pro-

gressed from some simple geometric principles (things the Greeks

were well aware of) to the more complex

formulations we understand today. The

reason this was possible is that the same

principles underlie today’s complex equa-

tions some of us seem to love. It seems

reasonable to decide that if the simple

concepts worked well in the past, they

might be sufficient to explain the more

complicated approach of the modern era.

What I try to do in this short presentation is use this approach to

generate some insight into what we do today along with what

works, why we need it and why it sometime is not as successful as

we would like. I end with a recipe for what seismic imagers will

be trying to do in the future, and explain why computers have

become such an integral part of the search for subsurface hydro-

carbons. Along the way I hope to at least attempt to shed some

light on available algorithms, how acquisition affects output

results why some algorithms are very sensitive to incorrect 

velocities, as well as how we usually get the velocities in the first

place. However, I promise not to use any equations more complex

than what your favorite Greek might put in a Trojan horse. n
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SIPES  
Luncheon Meeting 

Thursday, March 16, 2006
Petroleum Club  •  800 Bell (downtown)
Social 11:30 a.m., Lunch 11:45 a.m.

Register online, call, fax or e-mail your reservation to Mrs. B.K. Buongiorno at
Tel: 713-651-1639, Fax: 713-951-9659, e-mail: bkspee@aol.com by 12:00 Noon,
Tuesday Jan 17, 2005. Members and Affiliates who register by Jan 17 pay $30.
The cost is $35 for guests, non-members, and new registrations at the door.
No-shows will be billed. You can now sign up for SIPES Meetings online 
at www.sipeshouston.org, but payment is still required by regular mail or at 
the door.

Migration Without the Math: Did the Greeks Really
Know All This?

by J. Bee Bednar
Panorama Technologies Inc.
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Seismic imaging has progressed

from some simple geometric

principles … to the more 

complex formulations we 

understand today.

Contract and Full Time Exploration and Production Staff
Geoscience, Management, Reservoir Engineers, Landmen, 

Information Technology, Production
We can provide you with the RIGHT people with the RIGHT skills and 

the RIGHT experience at the RIGHT price, time and location!
Why spend all your scarce management time looking for staff when we 

can do it for you? Founded in 1999, GeoExperts is staffed and led by E&P
professionals with decades of experience in the worldwide oil industry

Tel: 713-953-0823, ext. 13, Fax: 713-2953-1642
(we also have offices in Canada, London and West Africa)

www.geoexperts.com
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It has long been recognized that repeated gravity surveys could

be used to track changes in either elevation or mass distribution

in the Earth. The technology to effectively track mass distribution

changes resulting in µGal level signals over long periods of time

has matured in recent years. The Prudhoe Bay, Alaska, water

flood surveillance project has hastened that development and set

a new standard for the conduct of time

lapse or 4-D gravity surveys. This talk will

review the history of the Prudhoe Bay

efforts and some of the milestones achieved

along the way.

The Prudhoe Bay reservoir water flood is

the largest ever undertaken and is intended

to repressurize the gas cap and maintain declining production

over a period of decades. It is difficult to monitor the progress of

the water due to a lack of wellbores located in the gas cap. The 

4-D seismic method will also be used, but it is limited by expense

and permafrost. In 1993 Jerry Brady and Don Walcott, then at

ARCO Alaska, started to consider the application of repeated 

surface and borehole microgravity surveys to monitor the 

water flood.

The University of Texas at Dallas (UTD) became involved in a

theoretical investigation of the possibility of gravity surveillance.

An inversion procedure was formulated and tested on synthetic

gravity data based on reservoir simulations. Various 4-D gravity

noise scenarios were proposed and the resolution of the method

determined. At about the same time (1994), a program of field

experiments was initiated to refine procedures for actually

obtaining the type of data required for the modeling. It soon

became clear that the state of the art would require some 

extension to achieve that goal.

In successive field experiments, conducted in the Arctic winter,

microgravity measurement techniques (both relative and

absolute gravity meters) and geodetic measurements using the

Global Positioning System were refined. The noise levels to be

expected in the 4-D gravity data were characterized and a 

long-term monitoring program was planned, involving about

300 stations. In 2002 a full-scale baseline survey was conducted

and late in that year water injection commenced. Repeat surveys

were conducted in 2003 and 2005, and a third survey is planned

for this year.

The 4-D data over the 2002 to 2005 interval

has been modeled and the water flood has

been detected. Model results resemble 

predictions from reservoir simulations but

are also producing unexpected results 

that should help the reservoir engineers

understand the actual situation in the

ground. The methodologies and standards developed for this

project are now being used to plan surveys in other areas. n
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by John Ferguson
University of Texas at Dallas

GSH Potential Fields Group
Dinner Meeting 

Thursday, March 16, 2006
HESS Building  •  5430 Westheimer, Houston
Social 5:30 p.m.

Cost: $25 
Reservations: Call or email Dale Bird, by noon Tuesday, March 14, 2006 
281-463-3816 or dale@birdgeo.com (email is preferred)

The 4-D Gravity Method and Water Flood
Surveillance at Prudhoe Bay, Alaska

The Prudhoe Bay reservoir

water flood is the largest

ever undertaken.
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Mass transport complexes form a significant component of

the stratigraphic fill in ancient and modern deep-water

basins worldwide. One such basin, the deep marine margin of

eastern offshore Trinidad, situated along the obliquely converging

boundary of the Caribbean and South American plates and 

proximal to the mouth of the Orinoco River, is characterized by

catastrophic shelf margin processes, intrusive and extrusive

mobile shales, active tectonics and prolific migration and 

sequestration of hydrocarbons. Major structural elements that

characterize the deep-water slope regions of this area include

• large transpression fault zones (i.e., Darien Ridge, Central

Range, Los Bajos) along which mobile shale walls are extruded,

• fault-cored anticlinal structures overlain by extrusive seafloor

mud volcanoes,

• shallow-rooted sediment bypass grabens near the shelf break,

and

• normal regional and counter-regional faults.

A mega-merged, 10,000-sq. km. 3D seismic survey reveals several

erosional surfaces that form the boundaries of enormous mass

transport complexes (MTCs). The data shows numerous episodes

of MTC development, characterized by chaotic, mounded seis-

mic facies and fan-like geometry. Their extent (6700 sq. km) and

thicknesses (up to 250 m) are strongly influenced by seafloor

topography. These systems show run-out distances from the

source area of 60 to 100 km. Depositional architecture identified

with these units include huge lateral erosional edges, linear basal

scours and side-wall failures. Mud volcanoes buffer deposition

and produce sediment shadows on their downdip side; these

depositional remnants are potential stratigraphic traps. MTCs are

believed to be produced by failures initiated by sediment accu-

mulation and oversteepening of the slope, tectonic movement,

high-frequency sea level fluctuations and/or possibly hydrate

destabilization and dissolution.

Several architectural elements documented in the MTCs in off-

shore Trinidad have been identified and described in similar

settings around the world. Basal scours are common in MTCs

located in the continental margins of offshore Brunei, offshore

eastern Borneo (Indonesia) and the Monterey channel-mouth

lobe in offshore California. Side-wall failures or syndepositional

faults have been described in outcrop studies in the Jackfork

Formation, Ouachita Mountains, of Arkansas. Equivalent 

“imbricate slices” have also been reproduced in laboratory 

gravity transport experiments. All these well-documented case

studies are used as potential analogs in the deep marine settings

of offshore Trinidad. The objective of this research is to better

understand the role that MTCs play in forming continental 

margins around the world and the effect that they have on fluid

flow and reservoir development within deep water basins. n
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Mass Transport Complexes in Offshore Trinidad 
and Worldwide Analogs

International Explorationists 
Dinner Meeting 

Monday, March 20, 2006
Westchase Hilton  •  9999 Westheimer
Social 5:30 p.m., Dinner 6:30 p.m.

Cost: $25 Preregistered members; $30 non-members & walk-ups

The HGS prefers that you make your reservations on-line through
the HGS website at www.hgs.org. If you have no Internet access, you
can e-mail reservations@hgs.org, or call the office at 713-463-9476.
(include your name, e-mail address, meeting you are attending, phone
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The 5th PESGB/HGS African Conference 
Second Announcement and Call for Papers

Africa: Elephants of the Future
QE2 Conference Centre, London 

September 12-13, 2006

Deadline for Abstracts: March 13
Africa continues to be an “elephant” of the upstream oil & gas industry. Growth in existing
fields and the potential for new elephant= and “rhino” sized fields will be the themes for the
PESGB/HGS 5th annual conference, which has established itself as the primary technical E&P
conference on Africa, at which attendance is expected to exceed 300+. 

The event will include a large poster program in addition to a comprehensive oral program of
about 25 high-quality talks. Based on early submissions, the program is expected to include
presentations by operators, consultants, governments and academia on

• Technologies to maximize recovery in existing giant fields (e.g., Algeria)
• Models for developing African gas resources (IHS)
• Remaining potential of West African deepwater petroleum provinces (e.g., Niger Delta,

Ghana, Mauritania)
• Salt tectonics of deepwater South Atlantic
• Prospects in highgraded frontier basins (e.g., Seychelles, Chad, Namibia, South Africa)

Further Abstracts (circa 200 words) should be sent as soon as possible, and no later than 
13 March 2006, to Duncan Macgregor at duncan.macgregor@neftex.com or duncan.macgregor2
@ntlworld.com. Extended abstracts are normally written once the papers are accepted and are
issued on a conference CD, which is again being kindly sponsored by ECL - RPS Energy. 

Details of early registration, sponsorship opportunities and associated exhibition space are
available from the PESGB office “Africa Conference”06’ at 5th Floor, 9 Berkeley St, London
W1J 8DW, UK; on the PESGB website www.pesgb.org.uk; or directly from jennie@pesgb.org.uk.

The conference committee includes in London: Ray Bate (Chairman), Duncan Macgregor (Technical 
Co-ordinator), Val Clure, Enzo Zappaterra and Mike Lakin (sponsorship), and for the HGS in Houston: 
Al Danforth, Ian Poyntz, Steve Henry and Gabor Tari.
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Study of conventional cores, well logs and seismic data in the

Kingdom Field and other parts of the Abo shelf complex

trend in eastern New Mexico and west Texas has led to new con-

cepts about the style of deposition and techniques for strati-

graphic subdivision of the Leonardian Abo Formation. The

implications of paleogeographic restoration of the Abo shelf,

combined with detailed description and interpretation of

conventional cores from nine wells in Kingdom Field, has result-

ed in the identification of four important depositional facies that

have significant control on reservoir character: supratidal/

terrestrial (up-dip and top seal), intertidal (reservoir grain-

stones), platform interior (reservoir barrier) and shelf-edge 

(secondary reservoir). A fifth facies, karst breccia, is also defined.

This study reveals that the most productive facies in Kingdom

Field (and along the trend) is the intertidal facies (peloid grain-

stones), not the shelf-edge facies (boundstone reef). High-resolu-

tion stratigraphic analysis combining Fischer plots, well log

cross-sections, and 3D seismic data shows that at least three

third-order sequence boundaries, associated with exposure of the

shelf and significant karsting, are intraformational in nature.n

Facies and Sequence Stratigraphy of the Abo
Formation in the Kingdom Field Area, Terry and

Hockley Counties, West Texas

by Anthony E. D’Agostino (speaker)*
OMNI Labs, Inc.
Houston, Texas
J. Michael Party
Wagner & Brown, Ltd.
Midland, Texas

HGS Northsiders 
Luncheon Meeting 

Tuesday, March 21, 2006
The Sofitel Hotel  • 425 Sam Houston Pkwy. North
Social 11:15 a.m., Luncheon 11:30 a.m.

Cost: $31 Preregistered members; $35 non-members & walk-ups

The HGS prefers that you make your reservations on-line through the
HGS website at www.hgs.org. If you have no Internet access, you can e-
mail reservations@hgs.org, or call the office at 713-463-9476 (include
your name, e-mail address, meeting you are attending, phone number and
membership ID#).
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Abrief historical overview of Pierce Junction, Texas will be pre-

sented, followed by the history of the Pierce Junction Oilfield,

District 3. Major W. Stevenson, Sr. a descendant of

Edward Ruthven Taylor, Pierce Junction’s first

mineral lease holder, will present his family’s rich

history that spans seven generations. Mr.

Stevenson and his wife Beverly D. Stevenson will

share their vision of the 21st Century Pierce

Junction, which still remains a thriving oilfield. As

a result of a paradigm shift in demographics,

Pierce Junction is now a land reuse project of the

City of Houston Mayor’s Office Brownfield

Redevelopment Program.

The Texas Railroad Commission Voluntary Cleanup Program is

also involved in the oilfield clean-up effort. n

References
http://www.houstontx.gov/brownfields/

http://www.rrc.state.tx.us/divisions/og/site_rem/VoluntaryClean

upProgram.html
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from Louisville, Kentucky, is

the Assistant to the Vice

Chancellor and Vice President

for Information Technology

at University of Houston. She

is also a doctoral student in

the Human Development and

Organization Program at The

Fielding Graduate Institute in

Santa Barbara. Ms. Stevenson has a Masters degree in planning

and administration from Antioch University in Yellow Springs,

Ohio, and earned a Bachelor of Science degree in education from

Western Kentucky University in Bowling Green, Kentucky.

MAJOR STEVENSON, SR., a fifth-generation Houstonian and gradu-

ate of Jack Yates High School, teaches world history and United

States history at Willowridge High School. Mr. Stevenson has a

Bachelor of Science degree in history from Saint Edward’s

University in Austin, Texas. In 1995, he competed nationally and

won a $25,000 James Madison Memorial

Fellowship, created by the United States

Congress, for graduate study of the United States

Constitution. The foundation received over 2000

applications for the award and Major Stevenson

was one of 50 recipients in the nation and one of

two in Texas selected. He studied at American

University and the University of Houston and

earned a Masters degree in history. The James

Madison Memorial Fellowship Foundation and

the State of Texas have recognized him as a dis-

tinguished teacher and constitutional scholar.

A Historical Overview of Pierce Junction

Environmental and Engineering Group  
Dinner Meeting 

Tuesday, March 21, 2006
Wildcat Golf Club  •  1200 Almeda Road  •  Houston, Texas 77045
NOTE DIFFERENT LOCATION AND TIME FROM USUAL MEETING
Cocktails and social hour from 5:30 p.m. – 6:30 p.m.
Buffet Dinner from 6:30 p.m. – 7:30 p.m. •   Speakers at 7:30 p.m.

Cost: $25 Preregistered members; $30 non-members & walk-ups

Make your reservations now on-line through the HGS website at www.hgs.org; or, by
calling 713-463-9476 or by e-mail to Joan@hgs.org (include your name, meeting you are
attending, phone number and membership ID#).

by Beverly and Major Stevenson
Land/Property Owners
Pierce Junction, Texas
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NOTE DIFFERENT LOCATION AND TIME FROM USUAL MEETING

A brief history of

Pierce Junction,

followed by the 

history of the Pierce

Junction Oilfield.
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psinfo@corelab.com 24-hour wellsite service hotline: 713-328-2121

NO ONE HAS MORE WAYS TO OPTIMIZE YOUR RESERVOIR.

HGS Executive Board 
Meeting

HGA Spring Trip to
Galveston

Page 56

6 7

20 22HGS International
Explorationists
Dinner Meeting

by L. Moscardelli 
“Mass Transport Complexes in Offshore

Trinidad and Worldwide Analogs”
Page 23

HGS North American
Explorationists Dinner

Meeting
by S. Dorobek   

“Late Paleozoic Deformation in the
Permian Basin Region: Styles, Patterns,

Kinematics and Effects on Petroleum
Reservoirs”

Page 33

HGS Northsiders 
Luncheon Meeting

“Facies and Sequence Stratigraphy of the
Abo Formation in the Kingdom Field Area,
Terry and Hockley Counties, West Texas”

Page 25
HGS Environmental and

Engineering Dinner Meeting
“A Historical Overview of Pierce

Junction” Page 27

HGS General Dinner 
Meeting

by I. Steinhoff (speaker)  and W. A. Hill
“The Value of an Integrated Subsurface

Model: 3D Seismic Limitations in
Prediction of Reservoir in the Grand Isle

Production Area, Offshore Louisiana”
Page 13

HGS General 
Luncheon Meeting

by A. Bouma, B. Hampton and 
B. Hewett 

“The Princess Discovery, Sub-Salt Gulf of
Mexico: Challenges of Sub-Salt Imaging in

a Fast-Paced Sub-Sea Development”
Page 35

Reservations:
The HGS prefers that you make your reservations on-line through the HGS website at
www.hgs.org. If you have no Internet access, you can e-mail reservations@hgs.org, or call
the office at 713-463-9476. Reservations for HGS meetings must be made or cancelled by
the date shown on the HGS Website calendar, normally that is 24 hours before hand or
on the last business day before the event. If you make your reservation on the Website or
by email, an email confirmation will be sent to you. If you do not receive a confirmation,
check with the Webmaster@hgs.org. Once the meals are ordered and name tags and lists are
prepared, no more reservations can be added even if they are sent. No shows will be billed.

NOTE – Different

location and time

for Engineering

and Environmental

Dinner Meeting.



NOW
you can make

your reservations 
on-line at

www.hgs.org

Members Pre-registered Prices:
General Dinner Meeting  . . . . . . . . .$25
Nonmembers walk-ups. . . . . . . . . . . $33
Env. & Eng.  . . . . . . . . . . . . . . . . . . .$25
Luncheon Meeting  . . . . . . . . . . . . .$30
Nonmembers walk-ups. . . . . . . . . . . $33
International Explorationists  . . . . . .$25
North American Expl.  . . . . . . . . . . .$25
Emerging Technology . . . . . . . . . . . .$25

2006 Science and
Engineering Fair 

of Houston (SEFH)
Page 7
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SIPES Luncheon 
Meeting

“Migration Without the Math: Did the
Greeks Really Know All This?”

Page 19
GSH Potential Fields Group

Dinner Meeting
“The 4-D Gravity Method and Water

Flood Surveillance at Prudhoe Bay, Alaska”
Page 21
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Upcoming GeoEvents
April 7 – 9
HGS Pre-Convention Short
Courses Page 49

April 8
HGS Short Course/Lunch 
“Ethics for Geoscientists”

April 9–12
2006 AAPG Annual Convention
George R. Brown Convention
Center, Houston, TX Page 38

April 11
HGS Landry’s Downtown
Aquarium Event Page 28

April 13
HGS Post-Convention Short
Course Page 49

April 18
Joint GSH/HGS Luncheon
“Uses, Abuses and Examples of
Seismic-Derived Acoustic Impedance
Data: What Does the Interpreter
Need to Know”

April 18
Environmental and Engineering
Dinner Meeting

April 20
SIPES Lunch Meeting
“Seismic/Sequence Stratigraphy —
Applications for the 21st Century”

April 24
North American Explorationists
Dinner Meeting
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The Permian Basin of West Texas and southeastern New

Mexico is located in the foreland of

the Ouachita-Marathon orogenic belt.

The basin was segmented into several

sub-basins by fault-bounded basement

uplifts during late Paleozoic deforma-

tion that coincided with shortening in

the Ouachita-Marathon orogen. The

north-south trending Central Basin

Platform (CBP) is one of these uplifts. It

strikes at a high angle to the front of the

orogenic belt. The CBP separates the

Delaware Basin to the west from the Midland Basin to the east

and is bounded by complex fault systems

that vary from steep reverse faults to

transpressional/transtensional deforma-

tion zones. The Ozona Arch is an eastern

extension of the southern CBP and separates

the Midland Basin from the Val Verde

Basin. The Ozona Arch likely represents a

broken forebulge that is bounded by

steeply dipping, east-west-trending fault

Late Paleozoic Deformation in the Permian Basin
Region: Styles, Patterns, Kinematics and Effects 

on Petroleum Reservoirs

HGS North American Explorationists
Dinner Meeting 

Monday, March 27, 2006
Westchase Hilton  •  9999 Westheimer
Social 5:30 p.m., Dinner 6:30 p.m.

Cost: $25 Preregistered members; $30 non-members & walk-ups

The HGS prefers that you make your reservations on-line through
the HGS website at www.hgs.org. If you have no Internet access, you
can e-mail reservations@hgs.org, or call the office at 713-463-9476.
(include your name, e-mail address, meeting you are attending, phone
number and membership ID#).

by Steven L. Dorobek 
Department of Geology & Geophysics
Texas A&M University
College Station, Texas

Before late Mississippian time,

the Permian Basin was a 

relatively stable tectonic region

characterized by extensive 

shallow-water 

carbonate sedimentation.
HGS North American Dinner Meeting

continued on page 39
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This paper (1) gives a brief overview of the

Princess Field and its setting in the Mars

Basin in the Gulf of Mexico, (2) discusses the

strategy and maturation of the sub-salt seis-

mic imaging and (3) analyzes the impact on

the field development.

The Princess discovery is located in 3700 ft of

water on the northern flank of the Mars Basin

on Mississippi Canyon blocks 765 and 766,

adjacent to the Ursa field (Fig.1). Shell is the operator for BP,

ExxonMobil and ConocoPhillips. The discovery well, drilled

in the year 2000 on a poorly-imaged sub-salt truncation

trap, penetrated stacked Upper Miocene turbidite reservoirs.

Given the large uncertainty associated with the sub-salt 

setting, the development system was chosen to anticipate

many different outcomes. This resulted in a four-well,

15,000 psi-capable, dual flowline sub-sea tieback to Ursa,

which can be expanded in the future. First production was

achieved late 2002 initially through a well drilled to Princess from

the Ursa Tension Leg Platform (TLP), followed in late 2003 by

the first production through the sub-sea system, some 31⁄2 years

after discovery. Challenges that were met during the development

not only pertained to the large subsurface uncertainty, but also to

the complexity of drilling high-angle extended reach wells

through shallow hazard zones and depleted reservoirs. Princess

Field is currently (April 2005) producing approximately 

45 MBOPD and approximately 95 MMSCFPD through four

wells from two different reservoirs.

Princess Field is hidden completely underneath the East Antares

salt body. At the time of discovery, the existing 3D data yielded no

sedimentary details of the field or even the position of the large

Antares salt overhang (Fig. 2). The discovery well was drilled

using a limited depth-migrated long-cable 2D image. A large

range in the estimated discovery volumes reflected the uncertainty

associated with the limitations of seismic imaging below salt and

the upside potential in untested stratigraphy and a possible

waterflood. To support initial appraisal and development activities

the first 3D image was obtained through executing a pre-stack

depth migration (PSDM) on existing 1988 seismic data. This sur-

vey proved to be in a reasonable orientation to illuminate

sub-salt, but lacked the offset range to provide more than a local-

ized image of the field. Consequently a 3D seismic survey tailored

to the specific sub-salt setting was acquired. This dataset has

undergone various rounds of reprocessing using a number of

pre-stack depth migration algorithms and velocity models 

(Fig. 3). Evaluation of this survey, integrated with well results and

borehole seismic data, has provided a step change in the further

characterization of the field. The seismic image at Princess is still

evolving with technology in pursuit of further development

opportunities in the field. n

HGS General 
Luncheon Meeting 

Wednesday, March 29, 2006
Petroleum Club  •  800 Bell (downtown)
Social 11:15 a.m., Lunch 11:45 a.m.

Cost: $30 with advance reservations, $35 for walk-ins, space available
($15 for Emeritus and Honorary).

The HGS prefers that you make your reservations on-line through
the HGS website at www.hgs.org. If you have no Internet access, you
can e-mail reservations@hgs.org, or call the office at 713-463-9476
(include your name, e-mail address, meeting you are attending, phone
number and membership ID#).

by Aafke E. Bouma, Bret D. Hampton
and Ben M. Hewett 

Shell Exploration and Production Company 
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Figure 1. Princess Field location map 

The Princess Discovery, Sub-Salt Gulf of Mexico:
Challenges of Sub-Salt Imaging in a Fast-Paced 

Sub-Sea Development

HGS General Luncheon Meeting continued on page 37
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ENDEAVOR NATURAL GAS, LP
Seeking Drill-Ready Prospects

Texas and Louisiana Gulf Coast
East Texas • North Louisiana

Large working interest and operations 
preferred but not required.

Contact: Bruce Houff
(O) 713 658-8555 • (F) 713 658-0715

(Email) bhouff@endeavorgas.com
1201 Louisiana, Suite 3350 • Houston, Texas 77002
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HGS General Luncheon Meeting continued from page 35 ____________________________________________________________________________________
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Biographical
Sketch
Aafke Bouma has

been working for

Shell Exploration

and Production

Company in New

Orleans for the

past five years as a

staff geophysicist

in the Mars Basin,

deepwater Gulf of Mexico. One of her prime

focuses has been the Princess sub-salt devel-

opment with all its imaging and interpretation

challenges. Prior to this assignment she served

for four years in Brunei as a production seis-

mologist and field development team leader,

working on stacked shallow deltaic

heavily faulted reservoirs, which

posed a whole different set of chal-

lenges. The first five years of her

career after joining Shell in 1992 were

spent in London, United Kingdom.

There she primarily worked in the

deepwater Atlantic Margin Venture as

exploration geophysicist. Aafke holds

an MSc in structural geology with a

minor in geophysics from the

University of Utrecht in the

Netherlands and is an active member

of SEG and AAPG.

Figure 2. (top) 3D time-migrated image
at the time of Princess discovery (N40W
acquisition) 

Figure 3. (bottom) Current 3D pre-stack
depth migrated image from dedicated
N30E acquisition

16945 Northchase, Suite 1600, Houston, TX  77060
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American Association of Petroleum Geologists
1 888 945 2274 ext. 617 or 1 918 560 2617

convene@aapg.org

Point your browser to www.aapg.org/houston. 
Click to register. Drive to the convention.

Less hassle. Fewer lines.
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Biographical Sketch
ANTHONY D’AGOSTINO is currently a

Geologic Advisor for OMNI

Laboratories in Houston. He has also

worked for Atlantic Richfield, TD

Geoscience and Petroleum Geoservices

(PGS) in both the domestic and inter-

national areas. He received his BS in

geology from Illinois St. University in

1978, and his MS from Northern

Illinois University in 1980. Since com-

pleting his graduate research on

Neogene benthic foraminifers of the Ross Sea Antarctica, his

attention has been focused on projects in bio-, litho- and

sequence stratigraphy, clastic and carbonate sedimentology, and

reservoir characterization. Major projects include studies of

Miocene sand systems of the Gulf of Mexico, Paleogene Wilcox

Group of the Gulf Coast, Oligocene of the Burgos Basin in

Mexico, Eocene Misoa Formation of west-central Venezuela and

several Paleozoic intervals of the Permian Basin and the U.S.

mid-continent. He has published (singly or with co-authors)

numerous biostratigraphy papers.

Over the past 2.5 decades Tony has been leader or co-leader of

numerous ARCO, AAPG and SEPM field trips. He is a member of

and has served in many leadership positions in AAPG, SEPM

(national, Gulf Coast and Permian Basin sections), West Texas

Geological Society, Houston Geological Society, the Pander

Society and, the North American Micropaleontology Section of

SEPM (NAMS), for which he was Secretary from 1996 to 2000.

HGS Northsiders Luncheon Meeting continued from page 25 _________________________________________________________________________

HGS North American Dinner Meeting continued from page 33 _________________________________________________________________________
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zones that accommodated oblique-slip displacement during late

Paleozoic time. The Val Verde Basin was the narrow foredeep in

front of the Marathon orogenic belt during Mississippian to early

Permian time.

Three main stages of late Paleozoic deformation can be recognized

across most of the Permian Basin, based on significant changes in

lithofacies distributions, various styles of deformation across the

basin, and where active deformation occurred over time. Before

late Mississippian time, the Permian Basin was a relatively stable

tectonic region that was characterized by extensive shallow-water

carbonate sedimentation. Minor en echelon folding reflected 

the initial regionally distributed right-lateral transpressional

deformation that developed during late Mississippian–middle

Pennsylvanian time. These folds probably record the earliest

phase of reactivation of deep, late Precambrian–early Cambrian

extensional fault systems that predated formation of the Tobosa

Basin, an ancestral sag basin that existed prior to late Paleozoic

foreland deformation and development of the Permian Basin.

Soon after deposition of the Strawn carbonate ramp facies during

a middle Pennsylvanian phase of relative tectonic quiescence,

renewed and amplified right-lateral convergence (i.e., dextral

transpression) enhanced structural relief along the flanks of the

asymmetrically faulted anticlines that are widely distributed

across the Permian Basin region. Variable erosion across the

crests of these asymmetric anticlines created tectonically

enhanced unconformities that may have influenced porosity and

permeability distributions within sub-unconformity lower and

middle Paleozoic strata. 3D seismic volumes from the southwest

Midland Basin show that some of these faulted anticlines also

have resolvable fault and fracture systems that might have 

influenced production from Strawn and older strata. During late

Pennsylvanian through Permian Wolfcampian time, widespread

en echelon folding and faulting across the basin diminished,

although right-lateral convergence continued and was mostly

accommodated along the boundaries of the CBP as oblique-slip

deformation and contraction. This last phase of deformation 

is dominantly expressed as steeply dipping reverse faults and

asymmetrical flower structures along the boundary fault zones 

of the CBP. Major uplift of the CBP also occurred during this 

last phase of intraforeland deformation and the CBP served as

the source for wedge-shaped, upper Pennsylvanian through

Permian Wolfcampian synorogenic periplatform deposits.

The entire area returned to tectonically stable conditions during

Leonardian time, which allowed development of extensive 

carbonate platforms that built away from the structural margins

of the CBP. n

Biographical Sketch
STEVE DOROBEK received his BS in geology from Ohio University

and his PhD from Virginia Tech. He has been a faculty member

in the Department of Geology & Geophysics at Texas A&M

University since 1987 and is currently Professor and holder of the

M.T. Halbouty Chair in Geology. He has worked in many 

sedimentary basins worldwide, and his current research focuses

on the role of tectonic deformation in carbonate-platform 

evolution and reservoir distribution.
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Houston - Jeff Rowe
T: +1 713 369 6123
jrowe@fugro.com

Calgary - Jim Genereux
T: +1 403 777 9280
jgenereux@fugroairborne.com

High resolution aeromagnetic data coverage throughout western Texas
For more information, visit www.fugroairborne.com or contact us.

NON-EXCLUSIVE AEROMAGNETIC AND GRAVITY DATA AND INTERPRETATION

Mexico

Texas

Gulf of Mexico

WEST TEXAS 
SURVEYS

WEST TEXAS 
SURVEYS
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Clayton Coble
Sam Houston State University

Clayton is a senior at Sam Houston State

University double majoring in Geology

and Geography. He is a member of both

the Sam Houston Association of Geology

Students and the Geographers of Sam

Houston. Clayton is also a lab instructor

for a new course called Geological Hazards. His areas of interest

are sedimentation and structural geology. Clayton will be graduat-

ing in December, 2006 and plans to attend graduate school.

Outside of school, Clayton’s hobbies include hunting and fishing.

Tony Courville
Lamar University

Tony Courville is a native of Lake

Charles, Louisiana. He graduated from

Sam Houston High School in 1999, and

attended BYU Idaho the following year.

After Tony finished his freshman year, he

served a two year mission for the

Church of Jesus Christ of Latter Day Saints. Following his mis-

sion, Tony attended Idaho State University while he waited for his

wife Deven to finish her undergraduate degree. Tony and Deven

then moved to Lake Charles, Louisiana where Tony attended

McNeese State University and began taking all of the geology

courses that the institution offered. After competing his studies at

McNeese, Tony enrolled at Lamar University where he is now a

senior scheduled to graduate in the Fall of 2006. Tony’s interests

include camping, hunting, attending amusement parks and other

outdoor activities. After graduation he plans to start his career in

geology. Tony’s areas of geological interest include subsurface,

environmental and hydrogeology.

Adam Halpert
Rice University

Adam Halpert is a junior at Rice

University majoring in Earth Science and

Policy Studies. He has participated in

research projects in both political science

and geology, and is currently working

with Dr. Julia Morgan on a project inves-

tigating the properties of fault gouge using discrete-element

computer simulations. Other awards he has received include the

Trustee Distinguished Scholarship, the Century Scholarship and a

National Merit Scholarship from Rice. Adam is a student member

of the AGU and the SEG. On campus, he is active in intramural

sports, Rice’s quiz bowl team and the Best Buddies volunteer organ-

ization. After graduation in 2007, Adam hopes to attend graduate

school to pursue a degree in geophysics.

John Kolvoord
University of Texas

John began college in the geosystems

engineering and hydrogeology program,

but after two semesters switched to

geology. John has been awarded several

scholarships including the Austin Gem

and Mineral Society, the John A. and

Katherine G. Jackson Memorial and the Thomas R. Banks

Memorial scholarships. While in school John worked for the

Bureau of Economic

HGS Undergraduate Scholarship Foundation
Presents Six Scholarships

The HGS Undergraduate Scholarship Foundation has been providing scholarships to deserving students since 1984. To date, over
$118,500 in scholarships have been awarded. This year the Foundation has awarded six scholarships totaling $10,500. Foundation
Trustee Susan Black presented the scholarships to the recipients at the February 13th HGS dinner meeting. Universities included

in the undergraduate scholarship program include Lamar University, Sam Houston State University, Stephen F. Austin State
University, Rice University, Texas A&M University, The University of Houston, and The University of Texas.

Prior to the dinner meeting, the students and several of the professors participated in a field trip to Core Laboratories. The
purpose of the tour was to show the students what it is like to be a geologist in today's petroleum industry. Presentations were
made to the students on the relative advantages of a career with large Exploration and Production (E&P) companies, smaller

E&P companies, and service companies. Many thanks are extended to Core Laboratories for generously hosting 
this event. The Foundation intends to make the tour a regular part of our scholarship program and invite other local 
companies to participate. If you believe that your company might like to host students in the future, please contact 

John Adamick at jada@tgsnopec.com.

Vitae for our scholarship winners are listed below. These students are to be commended for their accomplishments.

Undergraduate Scholarships continued on page 43
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Geology, the Subsurface Library, and a small oil and gas explo-

ration company part-time. He graduated with a BS degree in

Geology from the College of Geosciences in December, 2005. John

is presently working as an intern with Hunt Petroleum

Corporation in Houston on an onshore Gulf Coast project. He is

currently studying for the GRE and will be applying for graduate

school soon. He enjoys all aspects of geology and has a particular

interest in sedimentology and stratigraphy. Outside of geology,

John enjoys backpacking, playing sports and lapidary arts.

R. Shane McGary
Texas A&M University

Shane is a junior in the geophysics pro-

gram at Texas A&M University. His

current projects include research into the

geophysics of hydrothermal vent systems

and a field project conducting a multi-

dimensional (seismic, EM, magnetic and

GPR) geophysical survey of the Odessa meteor crater. He is pri-

marily interested in electromagnetic geophysics and plans to

pursue a PhD following graduation in May 2007.

Bobbie Rappe
Stephen F. Austin State University

Bobbie is currently a graduate student at

Stephen F. Austin State University where

her main interests are hydrology and

geochemistry. She received her Bachelor

of Science degree in December, 2005.

While an undergraduate student at SFA,

she was Vice President of Sigma Gamma

Epsilon, President of the Geology Student Association, Volunteer

Coordinator of the AAPG, and worked at the Soil Lab on campus.

While serving as Volunteer Coordinator for the AAPG, the SFA

geology department won the National Student Chapter award.

While at SFA, Bobbie received awards in mineralogy, geochem-

istry and geomorphology. She was also awarded the Frank and

Eva Hood Goldberry Field Camp Scholarship before heading off

to field camp in the summer of 2005. Her hobbies include back-

packing, traveling, volunteer work, fossil collecting and

photography. Bobbie’s plans for the future include working in 

the field of hydrology and possibly traveling to less fortunate

countries to offer her assistance. n

“The Place to Go”
For GOM Gravity Data and Interpretations

Complete, New
Data Coverage

PSDM Support
3D Modeling

Fugro Robertson Inc.
(Formerly Fugro-LCT)
GRAVITY AND MAGNETICS
Brian Anderson – Dave Schwartz
Tel: 713-369-6100 www.fugro-lct.com

HGS Undergraduate Scholarships continued from page 41 _____________________________________________________________________________________________
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P.O. Box 941088    Houston, TX 77094    tel 281.560.3010    fax 281.855.6711
www.manzanitaservices.com
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The Geo-Legends Dinner was

held January 9, 2006. Following

the previous legends dinners exam-

ples, the attendance was an impres-

sive 270. Many thanks go to Linda

Sternbach for her efforts in organiz-

ing an outstanding meeting.

At Geo-Legends we also had some

of the new generation of geologists

volunteer to help with the distribu-

tion of “Rose’s Rules” from Pete

Rose and with the collection of the

“question cards” for the question-

and-answer portion of the meeting.

We thank the following members

for greatly contributing to the smooth

operation of the meeting: Emily

Wall, Christie Rogers and Shawn

Adamson from ExxonMobil, and

Mike Wall, Robyn Marchand and

Kari Parsons from Kerr McGee. n

The Geo-Legends
(left to right)
Peter Rose, Arnold
Bouma, Peter Vail
and Albert Bally

(left to right) Jeff Lund, Peter Rose and Dave Rensink

Charles and Linda Sternbach

Andre Droxler and Gabor Tair (left to right) Craig Moore, Paul Hoffman, Denise Stone and Matt Boyd

Geo-Legends 
2006

by Paul Britt
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Capital available for drill ready prospects 
and select drilling ideas

• Must have running room
• Targeting low to moderate risk
• Non-pressure
• Less than 12,000 feet depth range
• Onshore US

Contact Bob Hixon  •  713-495-6551  •  bhixon@enervest.net

EnerVest Management Partners, Ltd.

Kevin J. McMichael

First City Tower 713-655-9700
1001 Fannin, Suite 777 Fax 713-655-9709
Houston, TX 77002 kmcmichael@claymoreexpl.com 
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NAPE 2006
by Paul Britt  •  photos by Edie Bishop

NAPE 2006 was held at the George R. Brown Convention

Center on Thursday and Friday, February 2–3. Attendance

exceeded expectations, with over 12,500 registered by the end of

the show. Prospects from all over the world were presented, with

an obvious emphasis on Gulf Coast regions, and deals were being

made and prospects were selling out on the floor of the show.

While NAPE is considered to be a great networking venue, in fact,

many business deals were being conducted, or will be closed

shortly, due to their presence in the show. The exhibit hall had 28

aisles of prospect and vendor booths, almost too many to cover in

the one and one-half days that the Expo spans.

The HGS is a sponsoring organization of NAPE, and the HGA

was very active in their volunteering for the Expo. The HGS also

had a booth on the exhibit hall floor. The photographs on this

page were provided by Edie Bishop, HGS/HGA Liason. n

HGS Booth (left to right) Marvin Smith, Ken Nemeth, Mac
MaKinney, Paul Carter

(left to right) Norma Jean Jones, Hellen Hutchison, Marilyn Burger,
Suzanne Howell

(left to right) Jim Ragesdale, Dick Bishop, Marvin Smith

Let the deals begin!

Bill Howell (center) wheeling and dealing.
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6619 Fleur de Lis Dr.
New Orleans, LA  70124-1429
(504) 488-3711  (504) 488-6292 Fax
paleostaff@paleodata.com

Arthur S. Waterman
     Norman S. Vallette
         Michael W. Center
            Albert F. Porter, Jr.
                 William H. McKee
                       Joshua D. Miller
                          Thomas M Reilly

NEW COMPREHENSIVE GULF BASIN
DEPOSYSTEM PROJECT

wDeposystem maps of 60 sequences 
from Jurassic to Recent for the 

            entire Gulf Basin.

by Richard H. Fillon, PhD. in 
association with Paleo-Data, Inc.

wAge database of over 200,000 wells from
Onshore LA, TX, AL, MS, FL, and

Offshore GOM  evaluated and
               integrated in a unified framework.
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HGS Short Course Offerings Announced 
for AAPG 2006

by Kara Bennett, AAPG 2006 Short Course Chairman

Be sure to register early for the HGS short courses at the

AAPG 2006 Annual Convention. There is a great line-up 

this year, ranging from foundation classes for early career 

geoscientists to business-oriented classes to technical opportuni-

ties that are once-in-a-lifetime offerings.

An Ethics Lunch lecture by Dr. Chris Mathewson from Texas

A&M is new this year, intended to fulfill the annual continuing

education requirements for Texas licensed geoscientists. On

Saturday, April 8, all short courses will break at the same time for

lunch, so you can attend the Ethics Lunch lecture, then return to

the course in the afternoon. You must register separately for the

Ethics lunch program, and of course if you prefer, you can attend

only the Ethics lunch.

Box lunches and refreshments are included in the cost of all

AAPG short courses this year. The AAPG 2006 HGS short course

offerings are:

• By-Passed Pays, By-Passed Plays, a half-day program of case

histories presented by Bill DeMis and Dan Hartmann. This

course will present case histories you will see nowhere else, and

it’s more than tight sands and low-resistivity, low-contrast pays!

• Introduction to Effective Reservoir Modeling, a workshop for

teams doing 3D-reservoir modeling projects from the BP

Reservoir Modeling team of Kirk Hird, Lisa Towery and Robert

Trythall.

• Dan Tearpock’s Petroleum Reserves: Avoiding Write-downs —

Overview of Recommended Geological Practices, which has

been a very popular HGS course for anyone wanting to make

accurate reserve estimates.

• Ted Beaumont and Doug Strickland’s Creative Petroleum

Exploration, which can open your eyes to new ways to see

existing data and find new reserves.

• Seismic Petrophysics, presented by Roger Young and Robert

LoPiccolo, will show you how to mesh subsurface and seismic

data sets to develop a seamlessly integrated geological interpre-

tation.

• Packaging and Selling your Prospect, an excellent 1⁄2 day 

how-to guide for presenting prospects to management and

investors, presented by HGS President-elect Steve Brachman.

• A 1⁄2 day review course for geoscientists preparing to take their

licensing exams called “So You Want to Pass the Professional

Geologist’s Licensing Exam?” This is a first-time offering, by

request of many HGS members.

• Introduction to Mudlogging will provide a great introduction

or review of the basics of mudlogging, complete with on-site

mudlogging trailer. This course is aimed at early career geosci-

entists and those of us that haven’t seen the inside of a logging

trailer for a while. It’s sponsored (lunch too!) and there will be

no cost to attendees, but you must register to attend.

Plus there are a number of excellent core workshops and other

short courses to be offered, including the popular “How to 

be an Independent” workshop. For a complete listing, see

http://www.aapg.org/houston/courses.cfm. Also, please note that

an incorrect date was listed in the convention announcement for

the Core Analysis for Sorbed Gas Reservoir Systems EMD

course. This 1-day workshop will be given Friday, April 7.

Be sure to register early to avoid the disappointment of having a

course you really want to take cancelled. The Houston geoscience

community tends to register late for short courses, but for AAPG,

courses must meet their minimums by early March to avoid can-

cellation. And of course there’s always the chance that your

course will sell out—so you have two good reasons to register

today! n

Tauber Exploration & Production Co.

Seeking Ready to Drill Prospects

Texas and Louisiana Gulf Coast

Contact: Tim Tade or David Voight

(O) 713-869-5656 (F) 713-869-1997

55 Waugh Drive, Suite 601  •  Houston, Texas 77007
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HGS Welcomes New Members

ACTIVE

William Babcock

Nathan Bedford

Tom Cheatham

Carlotta Chernoff

Phillip Duggin

James Forsythe

Laurens Gaarenstroom

Robert Hargett

David Wm Harris

Robert Harvey

Jennifer Highnote

Frederick Hoffman

Renzo Huijsmans

Paul Jones

Mitsura Kamon

Ryan Krueger

Danuta Lipscomb

Maynard Little

William Mitchell

Jerry Moore

William Parker

Olatunde Soyinka

Antonio Tisi

Robert Webster

Ann Worrel

Kimberly Wright

ASSOCIATE

Spencer Davies

Skip Pack

Welcome New Members

Effective February 1, 2006
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TAKING 
DRILL-READY
PROSPECTS

CONTACT: DAN KELLOGG x103
DENNIS FERSTLER x104

DKELLOGG@ALPINERES.COM
(713) 655-1221 TEL
(713) 951-0079 FAX

1201 LOUISIANA, SUITE 3310
HOUSTON, TEXAS 77002
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Texas Board of Professional Geoscientists
The Texas Board of Professional Geoscientists (TBPG) proposes

amendments to 22 Texas Administrative Code Chapter 851,

§851.28, concerning license renewal. The proposed amendments

outline renewal procedures for licenses that are allowed to expire

for over 60 days. The statute currently stipulates that a license

that is not renewed within 60 days past its expiration date cannot

be renewed, but does state that “the board by rule may establish

conditions for the re-issuance of a license that has lapsed,

expired, or been suspended or revoked.” Thus, as per the 

proposed amendments, a license not renewed within 60 days past

its expiration date will now be considered lapsed and can be

renewed according to the conditions set forth in the proposed

amended rule. In addition, a license that is allowed to lapse for

over a year but less than three can also be renewed in accordance

with the proposed amended rule. This would change current

TBPG policy stating a license becomes permanently expired

when not renewed within one year of its expiration date. The

amended rule also stipulates that the Board may suspend or

revoke a license as disciplinary action for violation of Board law

or rules. The amended rule outlines how a revoked or suspended

license can be reinstated. For more information go to

http://www.sos.state.tx.us/texreg/sos/PROPOSED/22.

EXAMINING%20BOARDS.html#350.

The TBPG has also released draft versions of proposed amend-

ments to Rules 851.30, Firm Registration, and 851.31, Temporary

Licenses. Firm registration will be required of all firms that

engage in the practice of professional geoscience for the public in

Texas. Temporary licenses are for persons who hold PG licenses

or their equivalent in other states or countries. The proposed rules

are located at the TBPG website, http://www.tbpg.state.tx.us/.

During an audit of all P.G. licensee files the TBPG discovered that

numerous licensees have yet to provide the agency with a copy or

sample of their P.G. seal, as required by §851.20(m) in the P.G.

rules. Beginning February 20, 2006, notification letters were sent

to these licensees asking them to comply with the rule. A list of

people who need to submit a copy of their P.G. seal can be found

at http://www.tbpg.state.tx.us/noseal.htm.

Even if you haven’t received a notice, you should check to see if

you are on this list. The TBPG maintains an electronic file of your

stamp and in a number of cases the copy was illegible. If you use

an embosser, you will also be on this list. Embossing your stamp,

rather than using an inked stamp, is legal, but won’t show up

when copied, which is normally not a problem. However, it

makes it more difficult for the TBPG to copy it for their files. The

TBPG says that they’ll lightly ink it when it comes in so it will

show up on the copy. You don’t need to ink the embossed seal.

RRC GIS Map Viewer 
You can now locate mapped oil wells, natural gas wells and

pipelines on the Texas Railroad Commission’s (RRC’s) website:

www.rrc.state.tx.us under “What’s New @ The RRC?” Public 

GIS Map Viewer for Oil, Gas and Pipeline Data or go to

http://www.rrc.state.tx.us/gis/index.html.

The information found on the Geographic Information System

(GIS) map viewer includes oil wells, natural gas wells, plugged

wells, dry holes, injection and disposal wells and permitted 

locations for new wells. Pipelines that carry petroleum crude oil

and natural gas also can be viewed through these maps. The

information provided by the maps is continually being updated

and refined as permit applications are received by the RRC. Oil

and gas well data and pipeline data are obtained from public

records at the RRC. The base map information was obtained

from the U.S. Geological Survey 7.5 minute quadrangle maps,

and the patent survey lines from Texas General Land Office maps

were projected onto the U.S. Geological Survey base.

To use the public viewer, Microsoft Internet Explorer version 5.5

or higher or Netscape version 6.1 or higher with Javascript

enabled are required. In addition, the public GIS viewer uses

pop-up windows, so users need to disable pop-up blocking soft-

ware when using this viewer.

AGI Government Affairs Monthly Review 
(December 2005)
Congress Reviews the National Environmental Protection Act

Congress is showing growing interest in revisiting and perhaps

rewriting the nation’s most comprehensive environmental legis-

lation, the National Environmental Protection Act. The act was

established in 1969 and most recently amended in 1982. The

House of Representatives’ Committee on Resources established

two task forces (Task Force on Improving the National

Environmental Policy Act and the Task Force on Updating the

National Environmental Policy Act) to consider changes to

NEPA. On December 21, 2005, the two task forces released a joint

report and the report is open for public comment until February

6. All comments about the report must address specific recom-

mendations and must be received in writing.

The 30-page report and instructions for submitting comments is

available as a pdf document from the House Resources

Committee Web site at http://resourcescommittee.house.gov/

nepataskforce/report/nepareport_finaldraft.pdf.

International Year of Planet Earth, 2008
On December 22, 2005, the United Nations General Assembly

adopted by consensus a

Government Update
by Henry M. Wise, P.G. and Arlin Howles, P.G.

Government Update continued on page 52
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Resolution by the United Republic of Tanzania and co-signed by

82 nations, to proclaim 2008 as the United Nations Year of Planet

Earth. The press release stated,

“By a draft on the International Year of Planet Earth, 2008, which

the Committee approved without a vote on 11 November, the

Assembly would declare 2008 the International Year of Planet

Earth. It would also designate the United Nations Educational,

Scientific and Cultural Organization (UNESCO) to organize

activities to be undertaken during the Year, in collaboration with

UNEP and other relevant United Nations bodies, the

International Union of Geological Sciences and other Earth sci-

ences societies and groups throughout the world. Also by that

draft, the Assembly would encourage Member States, the United

Nations system and other actors to use the Year to increase aware-

ness of the importance of Earth sciences in achieving sustainable

development and promoting local, national, regional and inter-

national action.”

Geoscientists and geoscience societies are strongly encouraged to

participate in the International Year of Planet Earth (IYPE).

More information about IYPE is available at http://www.esfs.org/.

Energy Department Revises Energy Prices Forecasts
On December 12, 2005, the Energy Information Administration

of the Department of Energy revised its 20-year forecast on energy

prices. The EIA concluded that oil prices will remain near about

$45 per barrel and average about $54 per barrel in 2025 compared

with earlier projections of prices dropping to $30 per barrel. Also

predicted were lower prices for natural gas, falling from current

highs of $14 per thousand cubic feet to less than $5 per thousand

cubic feet as long-term demand wanes, especially for electricity

production.

The EIA lso scaled back the expected growth of liquefied natural

gas in the United States as worldwide demand increases, forecast

that coal will remain the primary fuel for producing electricity

until at least 2030 and predicted United States energy demand

will increase by 1.1% per year until 2030.

The full report is available at http://www.eia.doe.gov/oiaf/aeo/.

Multihazard Mitigation Report
The Multihazard Mitigation Council of the National Institute for

Building Sciences released its report on the cost of mitigation.

The study shows that money spent on mitigation saves lives,

reduces risks and reduces economic losses. On average for every

$1 spent on mitigation, the United States will gain about $4 in

future benefits. FEMA grants to mitigate hazards from 1993 to

2003 are expected to save at least 220 lives and prevent about

4,700 injuries over the next 50 years. Societal benefits from

FEMA grants over the same period yielded a discounted present

value of $14 billion compared with the $3.5 billion employed in

hazard mitigation programs. The potential annual savings to the

federal treasury is about $970 million compared to $265 million

per year in costs for the grants. The council recommends that the

federal government invest in mitigation on an ongoing basis

before and after disasters, increase knowledge and promote 

institutional commitments to mitigation at the local level and

support a structured process for the assessment of buildings and

infrastructure before and after disasters.

The full report is available at www.nibs.org/MMC/mmchome.

html.

Going Back to the Moon
Paul Spudis, a lunar scientist at Johns Hopkins University’s

Applied Physics Laboratory and a member of President Bush’s

Commission on the Implementation of U.S. Space Exploration

Policy, published an editorial in the Washington Post on

December 27, 2005, on why the United States should go back to

the moon. He stated that lunar exploration was important for

science, inspiration and resources.

The full text of Spudis’ editorial is available at http://www.

washingtonpost.com/wpdyn/content/article/2005/12/26/AR2005

122600648.html.

Geoscience Teacher Training Grants from NSF
The National Science Foundation (NSF) Directorate for

Geosciences has initiated a grant program called GEO-TEACH.

The program will support projects to improve the quality of

geoscience instruction, primarily at middle- to high-school levels.

The deadline for submitting a letter of intent is February 15, 2006,

and the deadline for proposals is April 17, 2006. More information

about the program is available at http://www.grants.gov/search/

search.do?mode=VIEW&oppId=7472.

Education Teachers Can Spend a School Year in Washington DC

The Einstein Fellowship program brings outstanding mathemat-

ics, science and technology education teachers to Washington,

DC to spend a school year working on Capitol Hill or in one of

several participating federal agencies. The purpose of the pro-

gram, as stated in the Albert Einstein Distinguished Educator Act

of 1994, is to provide outstanding educators with an opportunity

to serve in the public policy arena and to bring the expertise,

unique insights and know-how of classroom teachers to the

Congress and other appropriate branches of the Federal govern-

ment. Application deadline has been extended until January 16,

2006. For more information go to http://www.triangle-

coalition.org/ein.htm. n

Government Update continued from page 51 ________________________________________________________________________________________________________________
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Last month I talked about saving Webpages as HTML files on

your hard drive. These are useful if you want to show some-

one else an interesting Webpage by attaching the file to an e-mail;

HTML files are also nice if you want to view a Webpage again

without having to get on the Internet.

What about saving the text content of a Webpage as a Word file?

If you have tried to copy and paste content from a Webpage into

Word you have probably had mixed success. If the Webpage con-

tains images, including ads, when you do a simple Edit>Select All

and then paste it into Word, you probably found that the paste

process takes a long time. The resulting Word file can be very

large and contains all kinds of graphics that you didn’t expect.

And worse, the text is usually in an undesirable format.

Here is what I suggest for saving text on the Web as a Word file:

first set your Word default font settings to what you like to use.

Go to Format>Font and then select the type of font, font style

(regular, bold, italic, etc.) and the font size you prefer. Windows’

default is Times New Roman, but you can select what you prefer.

Then select “Default”. Word will ask you if you really want to

change your default settings and you should select “Yes”. You can

always change the default again later.

Select Format>Font from the Word tool bar

Select the Font, Font Style and Size you like. Select “Yes” when asked if
you want this to be your default setting.

Converting Webpages Into Text and More About
Saving HTML Files

Webnotes continued on page 54
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Now you are ready to take text off the Web and transfer it into a

Word document. Find the Webpage you want and manually

select what you wish to copy, trying to avoid graphics or unwanted

text. Now you can copy it by either typing CTRL + C, right 

clicking with your mouse and selecting “copy” or using the 

pull-down menu command Edit>Copy.

Right click with your mouse and select “Copy”.

Now go to your open Word document and, rather than doing a

simple paste, go to the menu bar and select Edit>Copy

Special>Unformatted Text. The text will paste into Word in the

default font, font style and font size that you set as your default. I

also like to go back and copy the URL from the Web browser

address line so I can easily refer back to the source.

From the Word tool bar, select Edit>Paste Special. Then select
“Unformatted Text” and select “OK”.

Here is your pasted output in Word.

When I submitted last month’s “Webnotes” on saving HTML files

to preserve Web pages, Bulletin Editor Paul Britt correctly pointed

out that different Web browsers (Internet Explorer vs. Mozilla

Firefox, for example) have somewhat different options for saving

Webpages as HTML files.

If you use Internet Explorer(IE), after you copy the Webpage and

select File>Save As, you have several options available. I will

briefly describe them.

Internet Explorer Save Web Page Options.

• Web Page complete (*.htm, *.html): this will save every piece of

the Webpage including image files in a folder. I don’t recom-

mend this option unless you want to re-create the Webpage for

some reason.

• Web Page HTML Only (*.htm, *.html): this is the option I

described in February’s Webnotes. This will preserve most of the

Webpage’s content and graphics but may not preserve all graph-

ic elements.

• Web Archive, single file (*.mht): this option captures and repro-

duces the Webpage in its full form including all graphics, so this

is probably the best option for you.

• Text file (*.txt): this will save the text only. When you want to

open it using Word you will have to change the “Files of Type” at

the bottom of the “File Open” dialog box from “All Word

Documents” to “All Files” and then you must step through a

Wizard to open the file in Word. Honestly, it’s kind of a pain and

the end result is a Word document with a very messy paragraph

and font format that will require a fair amount of clean-up

before you can use it.

If you use Firefox, the options are somewhat simpler and do not

include the Web Archive selection.

• Web Page complete is exactly the same as it is in IE.

• Web Page HTML Only is exactly the same as in IE.

• Text file is the same as in IE.

• All Files is the same as Webpage HTML only. n

Mozilla Firefox Save Web Page Options.

EDITOR’S NOTE: While it is okay to copy web content for personal

use, the user should keep in mind that most content is copyrighted by

default, and if it is to be used for reproduction or distribution, writ-

ten permission should be sought from the author before such use.

Webnotes continued from page 53________________________________________________________________________________________________________________
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Qualifications for Active Membership
1) Have a degree in geology or an allied geoscience from an accredited

college or university; or
2) Have a degree in science or engineering from an accredited college

or university and have been engaged in the professional study or
practice of earth science for at least five (5) years.

Qualifications for Associate Membership (including students)
1) Be involved in the application of the earth or allied sciences.
2) Be a full-time student enrolled in geology or in the related sciences.

Annual Dues Expire Each June 30. (Late renewals – $5 re-instatement fee)
Annual dues are $24.00; full-time students and emeritus members pay $12.00.
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Application to Become a Member of the Houston Geological Society

To the Executive Board: I hereby apply for  q Active  or  q Associate membership in the Houston Geological Society and pledge to abide by
its Constitution and Bylaws. q Check here if a full-time student.

Name:
Address:

Home Phone: Spouse’s Name:
Email:
Job Title:
Company:
Company Address:

Work Phone: Fax Number:
Circle Preferred Mailing Address: Home        Office
Professional Affiliations:
q Active AAPG Others:

Professional Interest: Membership Directory 
q Environmental Geology Preference
q International E&P q CD Rom
q North American E&P (other than Gulf Coast) q Printed
q Gulf Coast E&P (onshore & offshore)

School
Degree Major Year

School
Degree Major Year

School
Degree Major Year

Earth Science Work Experience

Applicant’s Signature Date

Endorsement by HGS member (not required if active AAPG member)

Name:

Signature Date

Membership Chairman HGS Secretary

rev. 2/7/2006

Mail this application and payment to:
Houston Geological Society
10575 Katy Freeway, Suite 290  • Houston, TX  77024
Telephone: 713-463-9476  Fax: 713-463-9160

Payment method: 

nn Check, nn VISA, nn MasterCard, nn American Express, nn Discover

Card # ______________________________________________

Expiration Date: ____________ Card I.D. __________________
(Card I.D. – 3 or 4 digit number on front or back of card )
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HGA and GeoWives News
HGA
by Edie Bishop, HGS/HGA Liaison

Another successful Winter NAPE was held at the George R. Brown

Convention Center on February 1 through 3. To walk into the

exhibit hall and feel the energy reaffirms that the petroleum indus-

try is alive and doing very well!  Thanks go to the many Society

and Auxiliary members who braved the early morning hours to

assist with the registration process. Individual thanks go to

Winona LaBrant Smith, Mary Harle, Betty Alfred, Linnie Edwards,

Vicki Pickering, Sally Blackhall, Margery Ambrose, Jim and Sara

Nan Grubb, Donna Parrish, Sara Parr, David and Lois Matuszak,

John and Helen Thomas, Jennifer Biancardi, Tom and Annette

Mather, Daisy Wood, Myrtis Trowbridge, Ann Koster, Paula

Fowler, George Bole, Dick Bishop, Dene Grove, Connie Griffith,

Suzanne Howell, Elinor Macmillan, Norma Jean Jones and Mikki

Wunderle. A special thanks to Hellen Hutchison for making us

part of this exciting event.

Moving to the social side of the Auxiliary, Game Day again proved to

be a resounding success. Daisy Wood and her committee provided a

wonderful program with a variety of games, great door prizes and a

scrumptious luncheon that is the trademark of the Junior League

Tea Room. The benchmark of a successful event is the attendance

and that number was approximately two-thirds of the membership

total! Hats off to Daisy and her team for this outstanding event.

Looking forward, March 26 is the date of the Auxiliary’s highlight

of the social year. To quote our First Vice President Winona LaBrant

Smith,“Come, enjoy a bus trip from Houston to the Grand Theater

in Galveston to view Thoroughly Modern Millie. This musical, a

winner of six Tony Awards, is set to the glorious music of the 20s.

View frisky flappers, a dashing leading man and a dragon-lady of

villainy. A box lunch with wine and beverages will be provided on

the bus. What a memorable way to spend a Sunday afternoon. This

trip will be limited to 56 persons—in the order received.” Please

send your inquiries to the Event Chairman Sally Blackhall.

“See you at something-HGS”

GeoWives
by Dene Grove

GeoWives Spring Trip 

On March 16 the GeoWives will travel to La Grange for another

day with history. La Grange was first settled in 1831, at a place

where an old buffalo trail crossed the Colorado River. We will visit

the State Park where the tombs of the fighters in the Dawson

Massacre of 1842 and the Mier Expedition of 1844 are. Both

fought against Mexico while Texas was a republic. LaGrange is

also in the central part of the area that was settled by Czechs in the

last part of the 19th century. We will visit the Czech Heritage

Center, where a replica of a Czech village is being built. The

Fayette County courthouse (built in 1891), where Marvin Zindler

had his wig pulled off by the sheriff during the “Chicken Ranch

War” of The Best Little Whorehouse in Texas fame, has been 

renovated along with the 1886 jail. We shall have time on the

square for lunch, touring and shopping. Out last stop will be at a

candy factory for a tour and some free samples to convince us to

buy more.

The day will start at Memorial Drive Presbyterian Church at 

8:15 a.m.. We will return between 5:30 and 6:00 p.m.. The cost is

$7.00 for entrance fees and miscellaneous items. We will have

lunch together but will be able to order and pay by separate checks.

Send your check (made payable to GeoWives) to Martha Lou

Broussard, 3361 Bellefontaine, Houston, TX 77025, by Monday,

March 13, to secure your reservation. Our thanks to our 

hostesses Martha Lou Broussard and Linnie Edwards for what

promises to be an entertaining and educational event. Guests are

welcome. n

You are invited to become a member of
Houston Geological Auxiliary

2005–2006 dues are $20.00
make check payable to Houston Geological Auxiliary and mail to: Norma Jean Jones •  14302 Appletree •  Houston, Texas

77079

HGA YEARBOOK INFORMATION
Last Name First Name Name Tag

Spouse Name Name Tag HGS Members Company

Home Phone Business Phone Business Fax
(     ) (     ) (     ) 

Street Address City Zip

Birthday, Month, Day ONLY Email Address Home Fax
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Professional Directory

As a HGA member you are invited to join

GeoWives
2005–2006 dues are $7.50

make check payable to GeoWives and mail to:

Dene Grove
12715 Pebblebrook

Houston, Texas 77024

Please provide the following

Name: ______________________________________________

Sreet Address: ________________________________________

__________________________________________________

City/State/Zip: ______________________________________

Telephone: __________________________________________

email: ______________________________________________

I will help plan a GeoWives activity

I will serve on a committee

Notification / Phone Committee

Courtesy / Hostess

My home is available for a meeting

GEOSCIENCE 
JOBS & 

PERSONNEL 
AVAILABLE!

Job Seekers:
During the past year, the HGS Jobs Hotline website has

averaged over 30 positions per month. New ads are
being posted almost every day!

Employers:
Get free listings, and a large response from qualified
candidates, for your ads. Our website averages nearly

11,000 website “hits” per month.

Current Jobs page at:
http://www.hgs.org/en/jobs/search.asp

Contact info:
Mike Cline at T/X Resources – Chairman, HGS

Personnel Placement Committee  •  (713) 665-5449 
mikec@txresources.com
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©

Systems

Sales
Reed Haythorne

Norm Stager
Dave Spaulding
William Zepeda

Wavefront LLC Oil & Gas Consultation 
since 1996

Steven “Eric” Getz
IT Support Consultation (Geophysical &

Geological)
Network, Workstation,  and Software Support

Seismic Data Loading
Seismic Modeling

Synthetic Seismogram Construction

(713) 305-5089 SMT Expert
EricGetz@EricGetz.com Microsoft Certified

Place Your 
Business Card Here!
$125.00 for 10 issues

713-463-9476

10575 Katy Freeway, Suite 290
Houston, Texas 77024
www.hgs.org

Office: 713-463-9476
Office Fax: 713-463-9160

ads@hgs.org

Lilly Hargrave
Advertising Coordinator
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811 Dallas 
Suite 1020

Houston, Texas 77002

JAMES B. BENNETT
Geology

RANDALL SCHOTT
Geophysics

Bus. (713)650-1378

3-D Seismic Interpretation, FTG Gravity Modeling,
Seismic Inversion and AVO analysis

6001 Savoy, Suite 110 • Houston, Texas 77036 
(713) 981-4650 • (281) 242-0639

E-mail: hunter3d@wt.net
Website: www.hunter3dinc.com 

P.O. BOX 140637
BOISE, ID 83714

BUS. 208-854-1037
RES. 208-854-1038
FAX. 208-854-1029

JAMES S. CLASSEN
Looking for close-in deals

ARK-LA-TEX LOG LIBRARY
400 TRAVIS, SUITE 500 • SHREVEPORT, LA 71101-3113

(318) 227-1641 • FAX (318) 227-1642 WWW.ARKLATEXLOGLIBRARY.COM
ELECTRIC LOG AND COMPLETION CARD COVERAGE:

LOUISIANA • EAST TEXAS • MISSISSIPPI • SOUTHERN ARKANSAS 
SOUTHEASTERN STATES

• PRIVATE WORK ROOMS • LOG & MAP COPIER
• IHS/DWIGHTS - CD/ROMS PRODUCTION DATA • COMPUTERIZED LOG DATA BASE

• CALL IN OR FAX DATA RETRIEVAL SERVICE    
• EXTENSIVE INDUSTRY REFERNCE & TECHICAL MATERIAL 

• BAR CODED CHECKIN/OUT
CALL FOR INFORMATION ON CORPORATE AND INDIVIDUAL 

MEMBERSHIPS OR DAILY USER RATES
MARILYN KILBOURNE, MANAGER
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7500 SAN FELIPE, SUITE 250
HOUSTON, TEXAS 77063

Geosolutions & 
Interpretations, LLC
Geology Geophysics Engineering

Phone:  (281) 679 0942
Fax:      (281) 679 0952
Mobile:  (281) 772 5826
800 Tully Rd, Suite 240K
Houston, TX, 77079

E_Mail: gj@geointerpretations.com
http://www.geointerpretations.com

Gerardo Jager
President

Place Your 
Business Card Here!
$125.00 for 10 issues

713-463-9476
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Maximum reservoir performance

Roxar’s integrated technology solutions
and services help companies of all sizes
realize the full economic potential of
their oil and gas resources.

• Innovative modeling
and simulation software

• Downhole monitoring
and control systems

• Reservoir production
multiphase metering

• Reservoir and production
consultancy

Roxar’s leading-edge technology solu-
tions from reservoir interpretation
through to production & process
meet the changing needs of users in
managing the entire reservoir lifecycle.

Want to make the
most of your valuable
oil and gas reserves?
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